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1. はじめに 
本書は ADVENTURE Project [1]において開発中の電磁界解析のための有限要素解析ソルバ 

ADVENTURE_FullWaveの使⽤マニュアルである． 

本章では ADVENTURE_FullWaveの概要および実⾏までの操作⼿順を説明し，2 章以降では本プログ
ラムの解析機能等を紹介する． 

 

1.1. 本プログラムの特徴 
ADVENTURE_FullWaveは以下のような特徴を持っている． 

・ ⾼周波電磁界問題の有限要素解析が可能 

・ 階層型領域分割法(Hierarchical Domain Decomposition Method: HDDM) [2][3][4][5]による負荷分散を
⾏った並列処理が可能 

・ 領域分割法を逐次処理するシングル版が使⽤可能 

・ MPI並列版が使⽤可能  

 

1.2.  稼働環境 
本プログラムは以下の環境で動作確認を⾏っている． 

対応プラットホーム ： Linux 

並列通信ライブラリ ： MPI 

その他 ： C コンパイラ，ADVENTURE_IO 

フリーの MPI ライブラリ[6]として有名なものに MPICH [7]がある．最近の Linux ディストリビュー
ションでは標準インストールされる場合もあるが，無い場合にはインストールが必要となる． 

・ MPICH の⼊⼿先 

https://www.mpich.org/ 

また，ADVENTURE_IO は ADVENTURE Project のホームページ 

http://adventure.sys.t.u-tokyo.ac.jp/ 

にアーカイブがあるのでこれをダウンロードし，ADVENTURE_IO のマニュアルに従ってあらかじめ
インストールしておく必要がある． 

 

1.3.  コンパイルとインストール 
ADVENTURE_FullWaveのモジュール群をコンパイルするには，C コンパイラ，MPI のコンパイル環
境，および ADVENTURE_IO がインストールされている必要がある． 

ADVENTURE_FullWaveのモジュール群のコンパイルとインストールをするには以下の⼿順に従えば
よい． 
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(1)アーカイブファイルの展開 

% gunzip  –c  AdvFullWave-b0.1.tar.gz  |  tar xvf - 

ただし，“%”はコマンドプロンプトを表しているため，実際には⼊⼒する必要はない．アーカイブフ
ァイルの展開により，AdvFullWave-b0.1 ディレクトリが作成される．また，AdvFullWave-b0.1 は次の
サブディレクトリを含んでいる． 

main ： ソルバのソースファイル 

doc ： ドキュメント類 

tools ： ツール類 

lib ： ライブラリ群 

sample_data ： サンプルデータ 
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(2)Makefile.in の編集 

展開したディレクトリに移動し，Makefile.in の編集を⾏う． 

 

# ************************************************************************* 

#   Copyright (C) 2000, 2001, 2002 Shinobu Yoshimura, 

#   The University of Tokyo, 

#   the Japan Society for the Promotion of Science (JSPS) 

#   Copyright (C) 2003, 2005, 2007, 2014, 2015, 2016, 2017 ADVENTURE Project, 

#   All Rights Reserved 

# ************************************************************************* 

 

# Include file for each Makefile 

# Please modify for your own environment 

 

# path  for  ADVENTURE_IO  system 

ADVSYSD = $(HOME)/ADVENTURE/bin ⇐ (A) 

 

# path for install directory 

INSTALL_DIR = $(HOME)/ADVENTURE  ⇐ (B) 

INSTALL_BINDIR = $(INSTALL_DIR)/bin 

INSTALL_DOCDIR = $(INSTALL_DIR)/doc 

INSTALL_DOCMAGDIR  = $(INSTALL_DOCDIR)/AdvFullWave 

 

# C compiler & linker 

CC = gcc  ⇐ (C) 

LINKER = $(CC) 

AR = ar 

ARFLAGS  = cr 

 

# parallel C compiler & linker 

MPI_CC = mpicc  ⇐ (D) 

MPI_LINKER  = $(MPI_CC) 

 

# Compiler options 

CFLAGS =  -O2  -Wall        ⇐ (E) 

CFLAGS_G     =  -g   -Wall 
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(A) ADVENTURE_IO の advsys-config がインストールされているディレクトリを絶対パスで指定
する．advsys-config は ADVENTURE_IO のインストール先として指定したディレクトリの直
下の binディレクトリにインストールされている．( ⾚⽂字の部分を ADVENTURE_IO のイン
ストール先として指定したディレクトリに変更すればよい) 

#  path  for  ADVENTURE_IO  system 

   ADVSYSD =   $(HOME)/ADVENTURE/bin 

 

(B) ADVENTURE_FullWaveのモジュール群やマニュアルなどをインストールするディレクトリを
絶対パスで指定する．(⾚⽂字の部分をインストール先に変更する) 

# path for install directory 

INSTALL_DIR   = $(HOME)/ADVENTURE 

c 

(C) 使⽤する C コンパイラを指定する．(⾚⽂字の部分を使⽤する C コンパイラに変更する) 

# C compiler & linker 

CC         =    gcc 

LINKER = $(CC) 

 

(D) 使⽤する MPI 環境に応じて MPI コンパイラを指定する．(⾚⽂字の部分を使⽤するMPI コ
ンパイラに変更する) 

# parallel C compiler & linker 

MPI_CC   = mpicc 

MPI_LINKER  = $(MPI_CC) 

 

(E) コンパイラの最適化オプションとオブジェクト・ファイルにシンボリック・デバッグ情報⽣成
するように指⽰するオプションを指定する．(⾚⽂字の部分を使⽤するオプションに変更する) 

# Compiler options  

CFLAGS   =  -O2  -Wall 

CFLAGS_G   =  -g  -Wall 

 

(3)コンパイルする 

% make 

 

(4)インストールする 

コンパイルに成功したら，以下のコマンドによりインストールを⾏う． 

% make install 

ただし，インストール先ディレクトリに書き込み権限を持ったユーザによって⾏う必要がある．これ
らの操作により，以下のファイルが(2)の(B)で指定したディレクトリにインストールされる． 
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⾼周波電磁界解析⽤実⾏モジュール 

・ bin/adv_fullwave-s  ：シングル版 

・ bin/adv_fullwave -p  ：静的負荷分散版 

・ bin/adv_fullwave -h  ：動的負荷分散版 

ツール類 

・ bin/adv_makefem  ：⼀体型 FEA モデル作成ツール 

  ・ bin/adv_makeUCD  ：AVS 可視化⽤ UCD ファイル作成ツール 

・ bin/adv_makepml  ：簡易的 PML作成ツール 

マニュアル 

・ doc/AdvFullWave/manual-jp.pdf ：⽇本語マニュアル 

 

1.4.  実⾏⽅法 
ここでは，ADVENTURE_FullWaveの静的負荷分散実⾏モジュールの実⾏⽅法を⽰す．また，並列
処理にはMPICHにおける実⾏⽅法を⽰す． 

% mpirun  [option for mpirun]  adv_fullwave-p  [option]  [data_dir] 

ここで，[option for mpirun]は mpirunに対するオプションであり，主なものとして以下のようなもの
がある．詳細はMPICHのマニュアルを参照． 

l -np n 

起動する MPI プロセスの数 n を指定する． 

l -machinefile machine_file 

並列計算に使⽤するマシン名のリストファイルを指定する．指定しない場合はシステムで設定され
ているデフォルトファイルが使⽤される． 

また，[options]は ADVENTURE_FullWaveに対するオプションである． 
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2. 並列処理機能について 
 

2.1.  並列処理機能 
ADVENTURE_FullWaveでは，階層型領域分割法[2][3][4][5]を⽤いることで並列処理を実現してい
る．図 1 に領域の階層型分割を模式的に⽰す．1 階層⽬の⼤きな分割単位を“部分”(part)と呼び，2 

階層⽬の細かい分割単位を“部分領域”(subdomain) と呼ぶことにする．これらの領域分割は
ADVENTURE_Metis によって⾏うことができる． 

 
図 1   階層型領域分割 

 

 

ADVENTURE_FullWave は並列ライブラリとして MPI[2]を⽤いており，起動時には指定に応じて複
数のプロセス(環境によってはスレッド)が起動される．1 ノード(CPU)あたり 1 プロセスを起動する
のが⼀般的であるが，1 ノードに対して複数のプロセスを割り当てることも可能である． 
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2.2.  領域分割(ADVENTURE_Metis)について 
ADVENTURE_Metis では，⾮常に細かい分割を⾏った場合，要素を⼀つも含まないような領域が作
られてしまうことがある．ADVENTURE_FullWave では実⾏時にそのような領域が存在すると，警告
を出して終了するようになっている．また，総要素数に対して⾮常に粗い分割を⾏った場合，計算量
が多くなったり，メモリ不⾜になったりすることがある． 

ADVENTURE_FullWave の計算性能は領域分割数に依存している．基本的に“part”数は並列処理の⼿
法，使⽤するノード数や計算機環境に基づいて決定される，“subdomain”数は計算処理に必要とされる
メモリに基づいて決定される．1 領域あたりの要素数を 100 前後にしたとき，計算時間およびメモリ
使⽤量の⾯で⽐較的良好な性能を得ることができることがわかっている[9]． 

 

ADVENTURE_Metis では，部分数𝑁!"#$と，1 部分あたりの領域数𝑁%&'()*"+,を指定して実⾏するた
め，総要素数𝑁-.-*-,$をとすると，1 領域あたりの要素数 n は次式によって与えられる． 

 

n	 = 	
𝑁-.-*-,$

𝑁!"#$ × 𝑁%&'()*"+,
 

  𝑁-.-*-,$ ：総要素数 
  𝑁%&'()*"+, ：領域分割数 
  𝑁!"#$  ：部分数 
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3. 解析機能 
 

ADVENTURE_FullWaveは、⾼周波電磁界解析が可能である．この解析における機能を以下に⽰す． 

 

3.1.  解析の流れ 
ADVENTURE システムを⽤いた⼀連の解析の流れは図 6 のようになっている．詳細は Appendix 

の C において，実際のコマンドを⽰しながら述べる． 

 

(1)   メッシュデータの作成 

ADVENTURE_CAD，ADVENTURE_TriPatch，ADVENTURE_TetMesh，商⽤ CAD などを⽤いて，
解析モデルのメッシュ分割を⾏う． 

 

(2)   境界条件の付加 

ADVENTURE_BCtool の msh2pch をもちいてメッシュ表⾯情報の抽出を⾏い，bcGUI を⽤いて境界
条件設定を⾏う．GUI による条件設定の詳細は ADVENTURE_BCtool のマニュアルおよび Appendix 

の A.1 を参照すること． 

 

(3)   ⼀体型解析モデルの作成 

ADVENTURE_FullWaveのツール advmag_makefem  を⽤いてメッシュ，物性値，境界条件から
ADVENTURE_IO フォーマットの⼀体型解析モデルを作成する． 

次に⼊出⼒ファイルのトップディレクトリ data_dir  を作成し，⼀体型解析モデルを
data_dir/model_one/ に移動する． 

 

% mkdir data_dir data_dir/model_one 

% mv input.adv data_dir/model_one/ 

 

(4)   領域分割 

作成した⼀体型解析モデルをもとに ADVENTURE_Metis を⽤いて階層型に領域分割されたモデル
を作成する．なお，実⾏時にはオプション -difn 1 を⽤いる必要がある．このオプションは内部境界
上節点の⾃由度を 1 に指定するためのものである．これは，構造解析で求める節点変位の⾃由度は 3

であるのに対し，電磁界解析では節点の⾃由度が 1 であるためである． 

 

(5)   解析の実⾏ 

ADVENTURE_FullWaveのモジュールを⽤いて，分割された解析モデルを⼊⼒として解析を⾏う． 
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(6)   解析結果の可視化 

ここでは AVS や ParaView などを⽤いて可視化する．最初に ADVENTURE_FullWave 付属のツー
ル adv_makeUCD を⽤いて UCD ファイルまたは VTK ファイルを作成しておく．  

 
図 2   解析の流れ 

 

 

4. 実⾏⽅法 
 

ADVENTURE_FullWaveは並列処理⽅法にて 2つのモジュールがある．それぞれ，次のコマンドで
実⾏を⾏う． 

l シングル版の場合 

%  adv_fullwave-s  [option]  [data_dir] 

l 静的負荷分散による並列版の場合(MPICH) 

%  mpirun  [options for mpirun]  adv_fullwave-p  [options]  [data_dir] 
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ここで，[options for mpirun]は mpirunコマンドに対するオプションであり，[options]は ADVENTURE 

_FullWaveに対するオプションである．このオプション指定により，解析種類の指定や，種々の設定
を⾏う．[data_dir]は必須オプションであり，⼊出⼒データのトップディレクトリを指定する．この下
のディレクトリおよびファイル名は 4.1.節に⽰す． 

 

4.1.  ⼊出⼒ファイル 
4.1.1. ファイル名 

各⼊出⼒ファイル名はデフォルトでは以下のようになっている．data_dir は⼊出⼒ファイ
ルのトップディレクトリ名であり，解析に関係する⼊出⼒ファイルは基本的にこのディレク
トリ内に置くことになる．なお，これらのディレクトリ名やファイル名は実⾏時オプション
で変更することも可能である．(4.3.5 項参照) 

・ ⼀体型解析モデルファイル ： data_dir/model_one/input.adv 

・ HDDM 型の解析モデル⼊⼒ファイル : data_dir/model/advhddm_in_P.adv 

・ 解析結果出⼒設定ファイル ： data_dir/result/advhddm_out.adv 

・ 解析結果出⼒ファイル ： data_dir/result/advhddm_out_P.adv 

・ 物性データファイル ： data_dir/mtrl.dat 

ここで，Pは部分番号を表す． 

また，これらのファイル以外に，物性データファイル内でファイル名を指定して使⽤する
⼊⼒ファイルがある．これらのファイルはディレクトリ data_dir 内からの相対パスでファイ
ル名が指定される．これらには以下のようなものがある． 

・ 形状定義ファイル 

なおこれらのファイルのフォーマットについては Appendix の「B. ⼊出⼒ファイルフォーマ
ット」を参照のこと． 

 

4.1.2. 使⽤するファイル 

 モジュールの⼊⼒ファイルと出⼒ファイルは以下のようになっている． 

adv_fullwave-s, adv_fullwave-p 

l ⼊⼒ファイル 

Ø HDDM 型の解析モデル⼊⼒ファイル 

Ø 物性データファイル 

Ø 形状定義ファイル 

Ø デルタギャップ給電データファイル 

l 出⼒ファイル 

Ø 解析結果出⼒設定ファイル 

Ø 解析結果出⼒ファイル 
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4.2.  単位系 
⼊⼒ファイルでの単位系の指定機能(⼀部の⾓度の単位指定を除く)や，プログラム内部での単位系
の変換機能は含まれていない．そのため，⼊⼒データ作成時に⽭盾のない単位系を使⽤しておく必要
がある． 

本マニュアルにおいて⼊出⼒ファイルフォーマットなどで単位に⾔及する場合は，すべて国際単位
系(SI)である．⼀部の基本単位を変更する場合には，組⽴単位など⽭盾のないように読み替える必要が
ある． 

 
図 3  単位系 

 

 

4.3.  実⾏時オプション 
4.3.1. すべてのモジュールに共通のオプション 

実⾏時に使⽤可能なオプションは以下の通りである．なお，オプションのあとにつく n，
x，s はそれぞれ整数，浮動⼩数点数，⽂字列を指定することを⽰し，その後に続く()はデフ
ォルト値を表す． 

・ -memlimit  n (1000) 

各プロセスが使⽤するメモリの上限を n [MByte]とし，これを越えた場合はその時点
で実⾏を停⽌する． 

・ -help または -h 

ヘルプメッセージを表⽰する． 

・ -version または -v 

モジュールのバージョンを表⽰する． 

 

4.3.2. HDDM に関するオプション 

ADVENTURE_FullWaveでは解法として，領域分割法に反復法を適⽤し，並列計算機に実
装した階層型領域分割法(HDDM)を⽤いており，それらをコントロールするためにいくつか
のオプションがある．これらのオプションは HDDM を⾏うシングル版(-s) ，静的負荷分散
版(-p) の各モジュールで指定できる． 

• -hddm-pc s (diag) 

HDDM で⽤いる前処理を指定する．s として指定できる⽂字列は以下の通りである. 
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・ none ： 前処理を⾏わない 

・ diag ： 簡易対⾓スケーリングを⽤いる 

・-hddm-eps x (時間調和渦電流解析では 1.0e-03) 

HDDM の収束判定値を指定する．これは，HDDM 反復における残差ベクトルの初期残差
ベクトルに対するノルムの相対誤差であり，相対誤差がこの値より⼩さくなった時点で 

HDDM 反復が収束したと判定する． 

・-hddm-div x (1.0e+10) 

HDDM が発散したと判定する値を指定する．相対誤差がこの値より⼤きくなった時点で 

HDDM 反復が発散したと判定し，プログラムを終了する． 

・-hddm-max-loop n (4000) 

HDDM 反復回数の上限を指定する．この値を超えた場合は，収束に⾄る前でもプログラム
は終了する． 

・-hddm-log または –hddm-no-log 

HDDM 反復の収束履歴を出⼒する／しないを指定する．デフォルトでは 

data_dir/calc_log/log_g_HDDM_Full_Wave 

に出⼒される． 

 

4.3.3. 部分領域の解法に関するオプション 

ADVENTURE_FullWaveでは HDDMの部分領域に⽤いる線形ソルバとして，反復法または
直接法を⽤いており，それらをコントロールするためにいくつかのオプションがある． 

・-l-sol-pc s (ICC) 

線形ソルバで⽤いる前処理を指定する．s として指定できる⽂字列は以下の通りである． 

・none ： 前処理を⾏わない 

・ICC ： 加速係数付き不完全 Cholesky 分解を⽤いる 

・-l-sol-ic-shift x (1.2) 

線形ソルバで前処理として不完全 Cholesky 分解を⽤いる場合の加速係数を指定する． 

・-l-sol-eps x (1.0e-09) 

線形ソルバの収束判定値を指定する．誤差がこの値より⼩さくなった時点で線形ソルバが
収束したと判定する． 

・-l-sol-div x (1.0e+10) 

線形ソルバが発散したと判定する値を指定する．誤差がこの値より⼤きくなった時点で線
形ソルバが発散したと判定し，プログラムを終了する． 

・-l-sol-log または –l-sol-no-log 

線形ソルバの収束履歴を出⼒する／しないを指定する．デフォルトでは出⼒しない． 
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4.3.5. ⼊出⼒ファイル名の変更オプション 

⼊出⼒に⽤いるファイルは 5.1 節で⽰したものが⽤いられるが，サブディレクトリ名やフ
ァイル名を変更したい場合は以下のオプションを使⽤する．ただし，P は部分番号を表して
いる．また，これらのオプションはすべてのモジュールで指定できるわけではなく，実⾏す
るモジュールがそれぞれのファイルを使⽤する場合にのみ指定できる． 

 ・-onedata-dir dir (model_one) 

⼀体型解析モデルファイルのあるサブディレクトリ名を dir とする． 

 ・-onedata-file file (input) 

⼀体型解析モデルファイル名を file とする．実際のファイル名は，これに.adv をつけたも
のとなる． 

 ・-model-dir dir (model) 

解析モデル⼊⼒ファイルのあるサブディレクトリ名を dir とする． 

・-model-file file (advhddm_in) 

解析モデル⼊⼒ファイル名を file とする．実際のファイル名は，これに_P.adv をつけたも
のとなる． 

・-result-dir dir (result) 

解析結果出⼒設定ファイルおよび解析結果出⼒ファイルのあるサブディレクトリ名を dir 

とする． 

・-result-file file (advhddm_out) 

解析結果出⼒設定ファイル名および解析結果出⼒ファイル名を file とする．実際のファイ
ル名は，解析結果出⼒設定ファイルがこれに.adv をつけたもの，解析結果出⼒ファイルがこ
れに_P.adv をつけたものとなる． 

・-mtrldat-dir dir (デフォルト値なし) 

物性データファイルのあるサブディレクトリ名を dir とする． 

・-mtrldat-file file (mtrl.dat) 

物性データファイル名を file とする． 
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Appendix 
 

A. ツール類について 
 ADVENTURE_FullWave には，本体モジュールの他に以下のツールが含まれている． 

 

A.1.  ⼀体型解析モデルファイル作成ツール  adv_makefem 
 adv_makefem は，電磁界解析⽤の⼀体型解析モデルファイル作成ツールである．このコマンドを使
⽤することで，ADVENTURE_BCtool において作成したメッシュ表⾯情報ファイルと境界条件設定フ
ァイルを⽤いて，電磁界解析⽤⼀体型解析モデルファイルを作成することができる． 

実⾏⽅法は，ADVENTURE_BCtool の構造解析⽤⼀体型解析モデルファイル作成モジュール 

makefemとほぼ同様である．以下に実⾏⽅法を⽰す． 

 

% adv_makefem mshFILE fgrFILE cndFILE matFILE advFILE [options] 

mshFILE  ： メッシュデータファイル(⼊⼒) 

fgrFILE ： メッシュ表⾯データファイル(⼊⼒) 

cndFILE  ： 解析条件ファイル(⼊⼒) 

matFILE  ： 物性値ファイル(⼊⼒) 

advFILE  ： ⼀体型解析モデルファイル(出⼒) 

 

 ただし，fgrFILE は mshFILE から ADVENTURE_BCtool の msh2pch により作成されるファイルで
あり，cndFILE は ADVENTURE_BCtool の bcGUI により作成されるものである．ここで，bcGUI が
作成するファイルは構造解析⽤であるため，電磁界解析⽤の境界条件設定メニューはない．そこで，
ADVENTURE_FullWaveでは x 軸⽅向の変位を 0 に設定することで代⽤するものとする． 

オプションについては 4.3.1 項を参照． 

 

A.2.  可視化ファイル作成ツール adv_makeUCD 
 adv_makeUCD は，解析結果出⼒設定ファイルと解析結果出⼒ファイルを読み込み，可視化するた
めの UCD ファイルまたは VTKファイルを作成するツールである．これらのファイルを⽤いて AVS 

/ Express，Micro AVS, ParaViewなどで可視化できる．どの種類のファイルを作成するかを指定するた
め，-avsfile (AVS / Express)，-avsfile-micro (Micro AVS)または-vtkfile(ParaView)のいずれかを実⾏時に
必ずオプションで指定する．以下に実⾏⽅法を⽰す． 

 

 %  adv_makeUCD  [options]  data_dir 

 

  ⼊⼒ファイル 

⼀体型解析モデルファイル 

HDDM 型の解析モデル⼊⼒ファイル 

解析結果出⼒設定ファイル 



  ADVENTURE SYSTEM 

-15- 
 

解析結果出⼒ファイル 

  出⼒ファイル 

   UCD ファイル 

⾼周波電磁界解析では磁界の実部(Hr)・虚部(Hi)，電界の実部(Er)・虚部(Ei)，電流
密度の実部(Jer)・虚部(Jei)の 6つのファイルを出⼒する．出⼒先は data_dir/result/で
あり，ファイル名は avs_*.inp となる．*にはそれぞれの値の種類を表す⽂字列(Hr, 

Ei 等)が⼊る．  

  ・-avsfile-dir  dir (result) 

サブディレクトリ名を dir とする． 

・-avsfile-file  file (avs) 

ファイル名を file とする．実際のファイル名はこれに_*.inp をつけたものとな
る．(*は Hr, Ei などの値の種類を表す⽂字列) 

また，以下のオプションを指定することで，Micro AVS のフォーマットで UCD 

ファイルを出⼒させることができる． 

・-avsfile-micro 

VTK ファイル 

以下のオプションを指定することで，VTK ファイルを出⼒させることができ
る． 

・ -vtkfile 

         ParaView などで扱え、⾼周波電磁界解析では磁界の実部(Hr)・虚部(Hi)，電界
の実部(Er)・虚部(Ei)，電流密度の実部(Jer)・虚部(Jei)の 6つのファイルを出⼒す
る．出⼒先は data_dir/result/であり，ファイル名は res_*.vtk となる．*にはそれ
ぞれの値の種類を表す⽂字列(Hr, Ei 等)が⼊る． 

・-vtkfile-dir  dir (result) 

サブディレクトリ名を dir とする． 

・-vtkfile-file  file (avs) 

ファイル名を file とする．実際のファイル名はこれに_*.vtk をつけたものとな
る．(*は Hr, Ei などの値の種類を表す⽂字列) 

 

A.3.  PML 付与ツール adv_makepml 
 PML(Perfect Matchd Layer：完全整合層)とは，⼊射した電磁波を反射させずに減衰させ，開放領域を
再現する吸収境界条件の⼀つである．adv_makepmlは，元のメッシュの形状表⾯分割パターンと完全
に⼀致した，元のメッシュを完全に取り囲む複数層のメッシュを作製するツールである．このコマン
ドを使⽤することで，作製したモデルに吸収境界条件である PMLを付与することができ，開放領域を
再現することが可能になる．ただし，付与する PMLは⽅向性を持たず，簡易的なものとする．以下に
実⾏⽅法を⽰す． 

% adv_makepml  mshFILE  mahFILEwithPML  nlayers  width_layer1  [ ．．．] 

mshFILE  ： メッシュデータファイル(⼊⼒) 

mshFILEwithPML ： PMLを含むメッシュデータファイル(出⼒) 
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nlayers  ： PMLの層数  

width_layer*  ： PMLの各層の厚さ 

 width_layer*の単位は元のメッシュと合わせる必要がある．Nlayersで指定した数だけ与える必要が
ある．PMLの厚さは波⻑の 1/10 程度にする． 

 

A.3.1. PML ⽣成⼿順 

PMLを⽣成する⼿順の概要を下図に⽰す． 

 
図 4  PML ⽣成⼿順の概要 

 

 元のメッシュの外形が直⽅体である(ただし⼨法は任意)ことを前提として， 

① 直⽅体頂点に対応する要素の追加 

② 直⽅体のエッジに対応する要素の追加 

③ 直⽅体の⾯に対応する要素の追加 

の順番で PMLを追加したメッシュを⽣成する． 
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 ただし，各層に導電率を与える必要があり，外側の層になるにつれて徐々に導電率を⼤きくしなけ
ればならない．また，直⽅体頂点・エッジに対応する要素の導電率は，⾯に対応する層の導電率の平
均値とする． 

 

B. ⼊出⼒ファイルフォーマット 

ADVENTURE_FullWaveでは，⼊出⼒ファイルとして以下のようなファイルを使⽤する． 

・⼀体型解析モデルファイル 

・HDDM 型の解析モデル⼊⼒ファイル 

・解析結果出⼒設定ファイル 

・解析結果出⼒ファイル 

・物性データファイル 

・形状定義ファイル 

・デルタギャップ給電データファイル 

これらのファイルのフォーマットを以下に⽰す． 

 

B.1.  ⼀体型解析モデルファイル 
このファイルは adv_makefem によって作成される ADVENTURE_IO 形式のファイルである．この
ファイルのデータ構造，特に Property 部分を以下に⽰す． 

 

######################################################## 

要素コネクティビティ 

######################################################## 

[Properties] 

1: content_type=Element 

2: num_items=(要素数) 

3: num_nodes_per_element=10 

4: dimension=3 

5: element_type=3DQuadraticTetrahedron 

6: format=i4i4i4i4i4i4i4i4i4i4 

 

######################################################## 

節点座標 

######################################################## 

[Properties] 

1: content_type=Node 

2: num_items=(節点数) 

3: dimension=3 

4: format=f8f8f8 
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######################################################## 

境界条件 

######################################################## 

[Properties] 

1: content_type=FEGenericAttribute 

2: num_items=(境界条件数) 

3: fega_type=NodeVariable 

4: label=DirichletBCs_Axn0 

5: format= 

6: index_byte=4 

 

######################################################## 

物性番号 

######################################################## 

[Properties] 

1: content_type=FEGenericAttribute 

2: num_items=(要素数) 

3: fega_type=AllElementVariable 

4: label=Flag 

5: format=i4 

6: index_byte=4 

 

######################################################## 

設定，その他 

######################################################## 

[Properties] 

1: content_type=FEGenericAttribute 

2: num_items=0 

3: fega_type=AllElementConstant 

4: label=Options 

5: format= 

6: index_byte=4 

7: ADVFW_NAME=(モジュール名“ADVENTURE_FullWave”) 

8: N_VERSION=(このファイルを作成したモジュールのバージョン) 

9: DirichletBCs_Axn0=NEED 
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B.2.  HDDM 型の解析モデル⼊⼒ファイル 
 このファイルは ADVENTURE_Metis によって作成される ADVENTURE_IO 形式のファイルであ
り，階層型の領域分割をされたメッシュデータが記録されている．このファイルのフォーマットにつ
いての詳細は ADVENTURE_Metis のマニュアルを参照されたい． 

 

B.3.  解析結果出⼒設定ファイル 
 このファイルは解析モジュールにより作成されるファイルであり，解析を⾏った際の条件などが記
録されている． 

 

B.4.  解析結果出⼒ファイル 
 このファイルは解析モジュールにより作成されるファイルであり，解析結果が記録されている．記
録される解析結果は未知⾃由度である電界・磁界・電流密度になる． 

 

B.5.  物性データファイル 
 このファイルは解析に必要な物性値や領域を設定するために使⽤されるもので，ユーザが作成す
る．このファイルを変更，または複数⽤意することで，物性値の変更などを伴う，パターンの違う解
析を⼿軽に⾏うことができる．ただし，境界条件の変更や，メッシュ⾃体の変更を伴う場合には，
ADVENTURE_BCtool，またはメッシュ作成からのやり直しが必要となる． 

このファイルで設定することのできる物性値や領域は以下の通りである． 

・ 誘電率[F/m] (必須，すべての物性番号に対して 1つずつ値を設定) 

・ アンテナ領域とアンテナに流す強制電流密度[A/m2] (任意，複数の指定が可能) 

・ 導体領域と導電率[S/m] 

・ アンテナに流す交流電流の⾓周波数[rad/s] 

それぞれの設定の仕⽅は以下の通り． 

(1)誘電率[F/m] (必須) 

 この値はすべての物性番号に対して 1 つずつ値を設定する． 

Permittivity 4 ←設定キーワード と 設定数 

0 7.957747e+05  ←物性番号 と 誘電率[F/m] 

1 7.957747e+05      ： 

2 7.957747e+05     ： 設定数分記載する 

3 7.957747e+05     ： 

 

(2)アンテナ領域とアンテナに流す強制電流密度[A/m2] 

 アンテナ領域は物性番号単位で設定を⾏う．次にアンテナに流す電流密度の値を強制電流密度デー
タファイルから読み込むか，形状定義ファイルから設定を読み込んで作成するかを選択し，そのファ
イル名を設定する．アンテナ領域は複数指定することができ，ファイル名はそれぞれのアンテナ領域
で設定することができる．もちろん，同⼀のファイルを複数のアンテナ領域で指定することも可能で
ある．  
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Antenna 2  ←設定キーワード と 設定数 

1 rf Jo  ←物性番号，ファイルの種類，ファイル名 

3 md antenna.dat   ： 設定数分記載する 

 ここで，rf とは強制電流密度の値を直接強制電流密度データファイルから読み込む(Read from File)

ことを意味し，md は形状定義ファイルから読み込んだ値の定義から，強制電流密度の値を作成する
(Make from Definition)ことを意味する．また，設定するファイル名は data_dir からの相対パスで指定
する．強制電流密度データファイル名はここで指定した⽂字列の末尾に，時間調和渦電流では r (実
部)，i (虚部)をつけたものとなる．よって，この例ではそれぞれのファイルは以下の場所から読み込ま
れる． 

・ data_dir/Jor ： 強制電流密度データファイル(時間調和渦電流解析・実部) 

・ data_dir/Joi ： 強制電流密度データファイル(時間調和渦電流解析・虚部) 

・ data_dir/antenna.dat  ： 形状定義ファイル 

 

(3)導体領域と導電率[S/m] 

 導体領域は物性番号単位で設定を⾏う．次にそれぞれの導体領域での導電率の値を設定する．導体
領域は複数設定することができる． 

Conductor 1  ←設定キーワード と 設定数 

0 7.700000e+06   ←物性番号 と 導電率[S/m] 

： 設定数分記載する 

 

(6)アンテナに流す交流電流の⾓周波数[rad/s] (時間調和渦電流解析で必須) 

 この値はすべてのアンテナで共通の値を 1 つだけ設定する．複数の設定はできない． 

AntennaOmega  ←設定キーワード 

3.769911e+02  ←⾓周波数[rad/s] 

 

実際の例を図 5に⽰す． 
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Permittivity   2 

0   8.854e-12 

1   8.854e-10 

 

Antenna   1 

1   md   antenna.dat 

 

Conductor   2 

0  0.0 

1  0.0 

 

AntennaOmega 

3141592653.59 
図 5 物性データファイル 

 

B.6.  形状定義ファイル 
 このファイルは解析領域内での強制電流密度を定義するためのファイルであり，ユーザが作成す
る．定義域として使⽤できる形状は以下の通りである． 

・扇形円筒(円筒の⼀部，または全部) 

・平⾏ 6 ⾯体(直⽅体，⽴⽅体等) 

 このファイルのフォーマットは以下の通りである． 

 

 全体 

Full-Wave  ←解析の種類 

     ： 

：  扇形円筒，平⾏ 6 ⾯体，時間変化の定義が並ぶ 

     ： 

 

扇形円筒 

DoubleSectorialCylinder ←扇形円筒の定義キーワード 

x y z ←基点の座標[m] 

(x, y or z)   h ←⾼さ⽅向(x,y,z のいずれか)   ⾼さ 

(deg or rad)   𝜃!	 𝜃" ←⾓度の単位の選択と⾓度 

(内側の半径[m]) (外側の半径[m]) 

(強制電流密度[A/m2]) 

 

 まず，最初に扇形円筒の定義キーワードを書く．扇形円筒の定義キーワードは
“DoubleSectorialCylinder”である．次に基点となる点の座標を記載する．3 ⾏⽬では基点からどの⽅向
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が⾼さ⽅向であるかを，⾼さとともに x，y，z のいずれかで指定する．4 ⾏⽬では扇形円筒の底⾯が
どの範囲であるかを指定する．まず，⾓度を 1 周 360°の度数法で表現するか，1 周 2πの弧度法で表
現するかをそれぞれ“deg”または“rad”で指定する．次に 2 つの⾓度を指定する．扇形円筒の底⾯は 2 

つの曲線(内径と外径)と 2 つの線分からなるが，この線分のうち 1 つが x，y，z 軸のいずれかとな
す⾓度(𝜃!)と，この線分ともう 1 つの線分がなす⾓度(𝜃")を指定する(図 10 参照)．なお，𝜃!を決定す
る場合に基準となる軸は次のようになる． 

 ・⾼さ⽅向に x を選んだなら，底⾯は yz 平⾯にあり，y 軸が基準となる． 

・⾼さ⽅向に y を選んだなら，底⾯は zx 平⾯にあり，z 軸が基準となる． 

・⾼さ⽅向に z を選んだなら，底⾯は xy 平⾯にあり，x 軸が基準となる． 

5 ⾏⽬では円筒の内側の半径と外側の半径を指定する．最後に強制電流密度の⼤きさを指定する．そ
の向きは⾼さ⽅向に選んだ軸と垂直な平⾯内を，⾼さ⽅向から⾒て右ねじの⽅向とする． 

 ・⾼さ⽅向に x を選んだなら，電流は yz 平⾯を y 軸から z 軸の⽅向に回る． 

・⾼さ⽅向に y を選んだなら，電流は zx 平⾯を z 軸から x 軸の⽅向に回る． 

・⾼さ⽅向に z を選んだなら，電流は xy 平⾯を x 軸から y 軸の⽅向に回る． 

また，強制電流密度は解析の種類によって値の数が違ってくる．時間調和渦電流解析では実部と虚部
の 2 つの値を指定しなければならない． 

 

 
 

図 6 𝜽𝟏 と𝜽𝟐 (zを⾼さ⽅向に選んだ場合) 
 

 

 

 

 

 

𝜃! 

𝜃" 
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 平⾏ 6 ⾯体 

Parallelpiped ←平⾏ 6 ⾯体の定義キーワード 

x0   y0   z0 ←基点の座標[m] 

x1   y1   z1 ←基点と隣り合う点の座標[m]，その 1 

x2   y2   z2 ←基点と隣り合う点の座標[m]，その 2 

x3   y3   z3 ←基点と隣り合う点の座標[m]，その 3 

(強制電流密度[A/m2] ) 

 

 まず，最初に平⾏ 6 ⾯体の定義キーワードを書く．平⾏ 6 ⾯体の定義キーワードは“Parallelpiped”

である．次に基点となる点の座標を記載する．3〜5 ⾏⽬では基点と隣り合う 3 点の座標を記載する
(図 7)．最後に強制電流密度をベクトルで与える．また，強制電流密度は解析の種類によって値の数が
違ってくる．  

 

 
図 7 アンテナの定義(平⾏ 6 ⾯体) 

 

形状定義ファイルを作成する上で注意すべきことは以下の通りである． 

・ これらの形状は複数のものを組み合わせて使うことができる． 

・ 形状の定義は実際のアンテナの⼨法よりも若⼲⼤きめにとる． 

実際のアンテナと全く同じ⼨法により定義した場合，定義域の隅において，数値計算上の誤
差のためにその定義域に本来含まれているはずの節点が含まれていないと判定されてしまう
ことがある．このため，定義は実際の⼨法よりも若⼲⼤きめにとる⽅がよい．ただし，他の
形状定義との重なりには注意すること． 

・ 形状定義が重なった場合，先に定義されている⽅が優先される． 
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B.7.  デルタギャップ給電データファイル 
 このファイルは解析領域内でのデルタギャップ給電を定義するためのファイルであり，ユーザが作
成する．このファイルのフォーマットは以下の通りである． 

1 ←与えるギャップ給電の数 

x0 x1  ←ギャップ幅の x 座標 

y0 y1  ←ギャップ幅の y 座標 

z0 z1  ←ギャップ幅の z 座標 

V  ←与える電位 

 

 まず，与えるギャップ給電の数を決める．次にギャップ幅の座標を決める．座標の決め⽅は，図 8

のような関係で決定する． 

 

 
図 8 ギャップ幅の座標の決め⽅ 

 

 最後に与える電位を決める．また，複数ギャップ給電を与える場合は，与えるギャップ給電の数を
決め，その分のギャップ幅の座標と与える電位を決める． 

 デルタギャップ給電を使⽤せず，強制電流密度を与える場合は，与えるギャップ給電の数を”0”とす
る． 
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C. 解析例(モデルの作成から解析まで) 

 ここでは ADVENTURE System を⽤いたモデル作成と，ADVENTURE_Metis による領域分割，こ
のモ デ ル の ADVENTURE_FullWave による解析例を⽰す．モデル作成には ADVENTURE_ 

CAD ，ADVENTURE_TriPatch，ADVENTURE_TetMesh，ADVENTURE_BCtool の各モジュールを⽤
いる．なお，本解析例で使⽤する各モジュールのバージョンは以下の通りである．各モジュールにつ
いての詳細はそれぞれのモジュールのマニュアルを参照のこと． 

・ ADVENTURE_CAD ： 1.8 

・ ADVENTURE_TriPatch ： 1.8 

・ ADVENTURE_TetMesh ： beta-0.91 

・ ADVENTURE_BCtool ： 2.1 

・ ADVENTURE_Metis ： 1.1 

 

C.1.  ⾼周波電磁界問題・簡易的なモデルの解析例 
 解析例として図 9の簡易的なモノポールアンテナモデルを使⽤する．空気領域は，半径 1.0[m] ，⾼
さ 0.4[m] の円柱空間で，この空間内に 0.015[m] ×0.015[m] ×0.4[m]のモノポールアンテナモデルを設置
する．透磁率𝜇は解析領域全体で 1/(4𝜋×10%&) [m/H]，誘電率𝜀は空気領域で8.854 × 10%!"，モノポール
アンテナ部分で8.854 × 10%!'，導電率𝜎はどちらの領域でも 0.0[S/m]，解析周波数を 500[MHz]とする
ために⾓周波数は2π × 500 × 10([rad/s]とする．アンテナに流れる強制電流密度 J の実部，虚部の⼤
きさは 0.08，0[A/m2]とする． 

 以降に解析例を⽰すのだが，ディレクトリ内に 

・ air.msh  :空気領域のメッシュファイル 

・ antenna.msh   :アンテナ領域のメッシュファイル 

を⽤意しているため，(1) ，(2)の⼿順を省くことができる． 

 

 

 
 

図 9 モノポールアンテナモデル(左図：アンテナ全体図 右図：アンテナ部) 
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 (1)解析モデル(モノポールアンテナモデル)の作成準備 

 まず，ADVENTURE_CADを⽤いて解析モデルを作成する．ADVENTURE_CADで⽤いる gm3dフ
ァイルのフォーマットについては ADVENTURE_CADのマニュアルを参照のこと．ここでは（ディレ
クトリ）にあるファイルを⽤いる． 

・ air.gm3d  :空気領域 

・ antenna.gm3d  :アンテナ領域 

・ antenna.ptn  :節点密度データファイル 

以下に ADVENTURE_CADの実⾏⽅法を⽰す. 

%  advcad air.gm3d air.pcm (pach_size) -pcm 

%  advcad antenna.gm3d antenna.pcm (pach_size) -pcm 

 

(2)内部に四⾯体メッシュを⽣成 

 ADVENTURE_TetMeshを⽤いて内部に四⾯体メッシュを⽣成する． 

 %  advtmesh9m airc -p 

 %  mv airc.msh air.msh 

 %  advtmesh9m antennac -p 

 %  mv antennac.msh antenna.msh 

 

 (3)メッシュの表⾯を抽出 

 msh2pchを⽤いてメッシュの表⾯を抽出する． 

 %  msh2pch air.msh 3 

 %  msh2pch antenna.msh 3 

 

 (4)表⾯パッチの結合 

 表⾯パッチ結合プログラム mrpachを⽤いて結合する． 

%  mrpach air_3.pch air_3.pcg antenna_3.pch antenna_3.pcg  

-o monopole_3.pcm -g monopole_3.pcg 

 

 (5)メッシュデータの作成 

 表⾯パッチをもとに ADVENTURE_TetMeshを⽤いてメッシュ分割を⾏う． 

 %  advtmesh9p monopole_3 

 %  advtmesh9m monopole_3c 

 %  advtmesh9s monopole_3c 

 

(8)メッシュの表⾯を抽出 

 msh2pchを⽤いてメッシュの表⾯を抽出する． 

%  msh2pch monopole_3cs.msh 3 
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 (9)境界条件の付加 

 ADVENTURE_BCtool を⽤いて境界条件を設定する．ただし，⼀体型解析モデルの作成には次項の
ように ADVENTURE_FullWave 付属のツールを⽤いるので，BCtool の makefem3 は使⽤しない． 

%  BcGUI2 monopole_3cs_3.pch monopole_3cs_3.pcg 

 

BcGUI を実⾏すると以下のようなウィンドウが開く． 
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今回は，円柱の側⾯は完全導体壁のため，境界条件は設定しない． 

境界条件の設定は，View → Boundary Condition → Cnd formatで確認する． 

 
 

 

解析条件ファイルを“antenna.cnd”というファイル名で出⼒する．(File → Save Condition) BcGUI を終了
する．(File → Quit) 

 

(9)⼀体型ファイルの作成 

 ADVENTURE_FullWaveのツール adv_makefemを⽤いてメッシュ，物性値，境界条件から 

ADVENTURE_IO フォーマットの⼀体型解析モデルを作成する． 

 まず，物性値ファイル“monopole.dat” を作成する ( 物性値ファイルの詳細については
ADVENTURE_ BCtool のマニュアルを参照)．ボリューム番号を確認するため，ADVENTURE_BCtool

のツール msh2pcm でメッシュ表⾯とボリューム境界を抽出し，それを BcGUI を⽤いて確認する． 

%  msh2pcm monopole_3cs.msh 

%  BcGUI2 monopole_3cs_V.pcm monopole_3cs_V.pcg 
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この作業により，ボリューム番号がそれぞれどの領域を表すかが以下のようにわかる． 

0 ： 空気領域 

1 ： アンテナ領域 

よって，材料の数を 2とし，それぞれの領域の物性番号を，空気領域は 0，アンテナ領域は 1，とす
る．また，ここではヤング率などの物性値は設定しないので，定義する物性値の数は 0 とする．以上
より，このモデルの物性値ファイルは以下のようになる． 

 

以下のコマンドにより，⼀体型解析モデルを作成する． 

% adv_makefem monopole_3cs.msh monopole_3cs_3.fgr antenna.cnd monopole.dat input.adv 

 

 次に，物性データファイル“mtrl.dat”を作成する．このファイルのフォーマットについては B.5を 参
照のこと．物性番号は全部で 2つあり，誘電率は空気領域で8.854 × 10%!"[F/m]，モノポールアンテナ
部分で8.854 × 10%!' [F/m]である．また，アンテナ領域は 1 つで，その物性番号は 1である． 

強制電流密度は形状定義ファイルから読み込むものとし，そのファイル名を“antenna.dat”とする．導 

monopole.dat 
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体領域はなく，どちらも導電率は 0.0[S/m]にする．⾓周波数は2π × 500 × 10( ≅ 3141592653.59[rad/s]

である．以上より，物性データファイルは以下のようになる． 

 

また，同時に形状定義ファイル“antenna.dat”を作成しておく．このファイルのフォーマットについて
は B.6を参照のこと．アンテナの定義域はあらかじめ⼤きくとっておく．よって，形状定義ファイル
は以下のようになる． 

 
また，同時にデルタギャップ給電ファイル“volt.dat”を作成しておく．このファイルのフォーマット
については B.7を参照のこと．今回はギャップ給電を与えないのでファイルは以下のようになる． 

 

最後に⼊出⼒ファイルのトップディレクトリ data_dirを作成し，⼀体型解析モデル
data_dir/model_one/ に移動する．現バージョンでは，data_dirのディレクトリ名を”MODEL”とするこ
と． 

% mkdir  MODEL  MODEL/model_one 

% mv  input.adv  MODEL/model_one/ 

% mv  mtrl.dat  MODEL/ 

% mv  antenna.dat  MODEL/ 

% mv  volt.dat  MODEL/ 

 

 

mtrl.dat 

antenna.dat 

volt.dat 
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 (9)領域分割 

 作成した⼀体型解析モデルをもとに ADVENTURE_Metis を⽤いて階層型に領域分割されたモデル
を作成する．なお，実⾏時にはオプション -difn 1 を⽤いる必要がある．このオプションは内部境界
上節点の⾃由度を 1 に指定するためのものである．これは，構造解析で求める節点変位の⾃由度は 3

であるのに対し，電磁界解析では節点の⾃由度が 1 であるためである． 

まず，階層型の領域分割をするために，部分(part)数と部分領域(subdomain)数を決定する．ここでは 

1台の PCの 6コアを⽤いて静的負荷分散版で解析することとする．このため，部分数を 6とする．次
に部分領域数であるが，(5)で作成した input.adv を ADVENTURE_IO のツール advinfo で確認する
と要素数が 43,641であることがわかる．(どの部分が要素数であるかは B.1 を参照のこと，要素数は
モデルを作成した環境によって同じ条件でも若⼲増減する) 

 

 % advinfo  MODEL/model_one/input.adv 

 

ADVENTURE_FullWaveでは 1 部分領域あたりの要素数を 100-200とすればよい(2.2 節参照)ので，
1部分領域あたりの要素数を約 100とすると， 

43,641(要素数)÷6(部分数)	÷100(1部分領域あたりの要素数)=72.735 

となるので，1 部分あたりの部分領域数を 73とする．なお，解析領域全体での部分領域数は 

 (部分数)×(1部分あたりの部分領域数) 

なので、436となる．領域分割は次のコマンド例のように⾏う． 

 

% mpirun  –np  6  adventure_metis  –HDDM  –difn  1   

MODEL/model_one/input.adv  MODEL  73 

 

 (9)解析の実⾏ 

 ADVENTURE_FullWaveのモジュールを⽤いて，分割された解析モデルを⼊⼒として解析を⾏う． 

解析は次のコマンド例のように⾏う． 

 

 % mpirun  –np  6  adv_fullwave-p  MODEL 

 

 

 (9)解析結果の可視化 

 ここでは ParaViewによる可視化の例を紹介する．まず，ADVENTURE_FullWave付属のツール
adv_makeUCD を⽤いて ParaView で読み込む VTK ファイルを作成する． 

 

 % adv_makeUCD  –vtkfile  MODEL 

 

図 10は ParaViewを⽤いて可視化した結果である． 
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図 10 電界虚部の可視化結果(xz平⾯) 
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C.2.  ⾼周波電磁界問題・並列計算環境での解析例 
⾼周波電磁界解析では，波⻑に対して⼗分に⼩さい要素によって要素分割する必要があり，そのた
めに要素数の増加を招く．これにより PC⼀台では計算できず，PCクラスタを⽤いて並列計算を⾏う
必要がある可能性がある．そこで並列計算の解析例として図 12のダイポールアンテナモデルに 8層の
PMLを付与したモデルを⽤いる．空気領域は 0.6[m] ×0.6[m] ×0.6[m]の空間で，この空間内に 0.015[m] 

×0.015[m] ×0.15[m]のダイポールアンテナモデルを設置する．透磁率𝜇は解析領域全体で 1/(4𝜋×10%&) 

[m/H]，誘電率𝜀は空気領域で8.854 × 10%!"，アンテナ部分で8.854 × 10%!'，PMLは全て8.854 × 10%!"

とする．導電率𝜎は空気領域・アンテナ部分は 0.0[S/m]，⾯に対応する PMLは外側にいくに連れて
徐々に導電率を⼤きく設定し，頂点・エッジに対応する PMLは⾯に対応する PMLの導電率の平均値
を設定する．解析周波数を 1.0[GHz]とするために⾓周波数は2π × 1.0 × 10)[rad/s]とする．アンテナに
流れる強制電流密度 J の実部，虚部の⼤きさは 0.08，0[A/m2]とする． 

 以降に解析例を⽰すのだが，ディレクトリ内に 

・ air.msh  :空気領域のメッシュファイル 

・ antenna.msh   :アンテナ領域のメッシュファイル 

を⽤意しているため，(1)，(2)の⼿順を省くことができる． 

 また，”dipole.dat”，”mtrl.dat”は値が多いので，⽤意した． 

 

 
 

図 12 ダイポールアンテナモデル(左図：アンテナ全体図 右図：アンテナ部) 
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 (1)解析モデル(ダイポールアンテナモデル)の作成準備 

 まず，ADVENTURE_CADを⽤いて解析モデルを作成する．ADVENTURE_CADで⽤いる gm3dフ
ァイルのフォーマットについては ADVENTURE_CADのマニュアルを参照のこと．ここでは（ディレ
クトリ）にあるファイルを⽤いる． 

・ air.gm3d  :空気領域 

・ antenna.gm3d  :アンテナ領域 

・ antenna.ptn  :節点密度データファイル 

以下に ADVENTURE_CADの実⾏⽅法を⽰す． 

%  advcad air.gm3d air.pcm (pach_size) -pcm 

%  advcad antenna.gm3d antenna.pcm (pach_size) -pcm 

 

(2)内部に四⾯体メッシュを⽣成 

 ADVENTURE_TetMeshを⽤いて内部に四⾯体メッシュを⽣成する． 

 %  advtmesh9m airc -p 

 %  mv airc.msh air.msh 

 %  advtmesh9m antennac -p 

 %  mv antennac.msh antenna.msh 

 

 (3)メッシュの表⾯を抽出 

 msh2pchを⽤いてメッシュの表⾯を抽出する． 

 %  msh2pch air.msh 3 

 %  msh2pch antenna.msh 3 

 

 (4)表⾯パッチの結合 

 表⾯パッチ結合プログラム mrpachを⽤いて結合する． 

%  mrpach air_3.pch air_3.pcg antenna_3.pch antenna_3.pcg  

-o dipole_3.pcm -g dipole_3.pcg 

 

 (5)メッシュデータの作成 

 表⾯パッチをもとに ADVENTURE_TetMeshを⽤いてメッシュ分割を⾏う． 

 %  advtmesh9p dipole_3 

 %  advtmesh9m dipole_3c 

 

 (6)PML付きメッシュデータの作成 

 pmlを⽤いて PML付きメッシュデータを作成する． 

 %  adv_makepml dipole_3c.msh dipole_pml_3c.msh 8 0.03 0.03 0.03 0.03 0.03 0.03 0.03 0.03  
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 (7)4 ⾯体 2次要素のメッシュデータの作成 

 ADVENTURE_FullWaveでは 4 ⾯体 2次要素を読み込むので、advtmesh9sを実⾏する。 

 %  advtmesh9s dipole_pml_3c 

 

 (8)メッシュの表⾯を抽出 

 msh2pchを⽤いてメッシュの表⾯を抽出する． 

%  msh2pch dipole_pml_3cs.msh 3 

 

 (9)境界条件の付加 

 ADVENTURE_BCtool を⽤いて境界条件を設定する．ただし，⼀体型解析モデルの作成には次項の
ように ADVENTURE_FullWave 付属のツールを⽤いるので，BCtool の makefem3 は使⽤しない． 

%  BcGUI2 dipole_pml_3cs_3.pch dipole_pml_3cs_3.pcg 

 

BcGUI を実⾏すると次のようなウィンドウが開く． 
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まず，⼿前の⾯に境界条件を設定する． 

 

 

BC → BC(Solid) → Add Displacement で xにチェックを⼊れ，境界条件の設定を⾏う． 
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同様に，残りの⾯にも境界条件の設定を⾏う． 

境界条件が適切に設定できているかを確認する．(View → Boundary Condition → Cnd format) 

 

 

 

解析条件ファイルを“antenna.cnd”というファイル名で出⼒する．(File → Save Condition) BcGUI を終了
する．(File → Quit) 

(9)⼀体型ファイルの作成 

 ADVENTURE_FullWaveのツール adv_makefemを⽤いてメッシュ，物性値，境界条件から 

ADVENTURE_IO フォーマットの⼀体型解析モデルを作成する． 

 まず，物性値ファイル“dipole.dat” を作成する ( 物性値ファイルの詳細については ADVENTURE_ 

BCtool のマニュアルを参照)．ボリューム番号を確認するため，ADVENTURE_BCtoolのツール 

msh2pcm でメッシュ表⾯とボリューム境界を抽出し，それを BcGUI を⽤いて確認する． 

%  msh2pcm dipole_pml_3cs.msh 

%  BcGUI2 dipole_pml_3cs_V.pcm dipole_pml_3cs_V.pcg 
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この作業により，ボリューム番号がそれぞれどの領域を表すかが以下のようにわかる． 

0 ： 空気領域 

1 ： アンテナ領域 

2 ： 直⽅体(空気領域)の頂点に対応する PML 

3 ： 直⽅体(空気領域)のエッジに対応する PML 

4〜27 ： 直⽅体(空気領域)の⾯に対応する PML 

よって，材料の数を 28とし，それぞれの領域の物性番号を，空気領域は 0，アンテナ領域は 1，直⽅
体(空気領域)の頂点に対応する PMLは 2、直⽅体(空気領域)のエッジに対応する PMLは 3、直⽅体(空
気領域)の⾯に対応する PMLは 4〜27とする．また，ここではヤング率などの物性値は設定しないの
で，定義する物性値の数は 0 とする．以上より，このモデルの物性値ファイルは以下のようになる．
なお，以下は sample_data 内に完成したもの（dipole.dat）がある． 

 

 

以下のコマンドにより，⼀体型解析モデルを作成する． 

adv_makefemのメモリ使⽤量の，上限のデフォルト値(1,000MB)では不⾜するため，オプション“-

memlimit 0”を設定すること． 

dipole.dat 
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% adv_makefem dipole_pml_3cs.msh dipole_pml_3cs_3.fgr antenna.cnd dipole.dat input.adv -memlimit 0 

 

 

 次に，物性データファイル“mtrl.dat”を作成する．このファイルのフォーマットについては B.5を 

参照のこと．物性番号は全部で 28あり、誘電率は空気領域で8.854 × 10%!"[F/m]、アンテナ部分で
8.854 × 10%!'[F/m]，PMLは全て8.854 × 10%!" [F/m]である．また，アンテナ領域は 1 つで，その物
性番号は 1である． 

強制電流密度は形状定義ファイルから読み込むものとし，そのファイル名を“antenna.dat”とする．導
電率は，空気領域・アンテナ部分は 0.0[S/m]，⾯に対応する PMLは外側にいくに連れて徐々に導電率
を⼤きく設定し，頂点・エッジに対応する PMLは⾯に対応する PMLの導電率の平均値を設定する．
⾓周波数は2π × 1.0 × 10) ≅ 6283185307[rad/s]である．以上より，物性データファイルは以下のよう
になる．今回は，“mtrl.dat”を⽤意しているため，作成する必要はない． 
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また，同時に形状定義ファイル“antenna.dat”を作成しておく．このファイルのフォーマットについて
は B.8 を参照のこと．アンテナの定義域はあらかじめ⼤きくとっておく．よって，形状定義ファイル
は以下のようになる． 

 

mtrl.dat 

antenna.dat 
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また，同時にデルタギャップ給電ファイル“volt.dat”を作成しておく．このファイルのフォーマット
については B.8 を参照のこと．今回はギャップ給電を与えないのでファイルは以下のようになる． 

 

 

最後に⼊出⼒ファイルのトップディレクトリ data_dirを作成し，⼀体型解析モデル
data_dir/model_one/ に移動する．ここでは data_dirをMODELとする． 

% mkdir  MODEL  MODEL/model_one 

% mv input.adv  MODEL/model_one/ 

% mv antenna.dat  MODEL/ 

% mv volt.dat  MODEL/ 

 

 (9)領域分割 

 作成した⼀体型解析モデルをもとに ADVENTURE_Metis を⽤いて階層型に領域分割されたモデル
を作成する．なお，実⾏時にはオプション -difn 1 を⽤いる必要がある．このオプションは内部境界
上節点の⾃由度を 1 に指定するためのものである．これは，構造解析で求める節点変位の⾃由度は 3

であるのに対し，電磁界解析では節点の⾃由度が 1 であるためである． 

まず，階層型の領域分割をするために，部分(part)数と部分領域(subdomain)数を決定する．ここでは 

4コアの PC 25台でなる PCクラスタを⽤いて 100並列で静的負荷分散版で解析することとする．この
ため，部分数を 100とする．次に部分領域数であるが，(5)で作成した input.adv を ADVENTURE_IO 

のツール advinfo で確認すると要素数が 15,712,684であることがわかる．(どの部分が要素数であるか
は B.1 を参照のこと，要素数はモデルを作成した環境によって同じ条件でも若⼲増減する) 

 

 % advinfo  MODEL/model_one/input.adv 

 

 

 

1部分領域あたりの要素数を約 100とすると， 

 

15,712,684 (要素数)÷100(部分数)	÷100(1部分領域あたりの要素数)=1,571.2684 

 

となるので，1 部分あたりの部分領域数を 1,571とする．なお，解析領域全体での部分領域数は 

 

 (部分数)×(1部分あたりの部分領域数) 

 

なので，157,100となる．領域分割は次のコマンド例のように⾏う． 

 

volt.dat 
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% mpirun  –np  100  -machinefile  machinefile.txt  adventure_metis  –HDDM  –difn  1   

MODEL/model_one/input.adv  MODEL  1,571 

 ここで，-machinefile はMPIのオプションである。 

 

 (9)解析の実⾏ 

 ADVENTURE_FullWaveのモジュールを⽤いて，分割された解析モデルを⼊⼒として解析を⾏う． 

解析は次のコマンド例のように⾏う．adv_fullwave-pのメモリ使⽤量の，上限のデフォルト値
(1,000MB)では不⾜するため，オプション“-memlimit 0”を設定すること． 

 

 

 % mpirun  –np  100  -machinefile  machinefile.txt  adv_fullwave-p   

-hddm-eps  1.0e-03  -hddm-max-loop  100000  -memlimit  0  MODEL 

 

 ここで，-machinefile はMPIのオプションである。また，adv_fullwave-pのオプションを⼊⼒しない
と正しく解析できない可能性がある。 

 

 (9)解析結果の可視化 

 ここでは ParaView による可視化の例を紹介する．まず，ADVENTURE_FullWave付属のツール
adv_makeUCD を⽤いて ParaView で読み込む VTK ファイルを作成する．adv_makeUCDのメモリ使
⽤量の，上限のデフォルト値(1,000MB)では不⾜するため，オプション“-memlimit 0”を設定すること． 

 

 % adv_makeUCD  –vtkfile  -memlimit 0 MODEL 

 

図 12は ParaViewを⽤いて可視化した結果である． 

 

図 12 電界虚部の可視化結果(左図：xy平⾯ 右図：xz平⾯) 
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